
THANKS!
I am delighted 
to announce 
that once again 
ShareScope has 
been voted the UK’s 
“Best Investment 

Software” by readers of both Investors 
Chronicle and Shares magazine. A huge 
thank you to everyone who voted for 
us, and to all our customers for your 
continued support. In the case of the 
Shares award this is now NINE years 
running whilst we have won the IC award 
eight of the last nine years.  I hope you 
find this three page issue helpful over 
what I hope is a 
fantastic Christmas 
and New Year
for you!

If you want to remove the statistical 
distribution graph from the Data Mining 
screen, simply right-click and de-select 
Graph.

Plus & Pro: If you want to learn more about 
Swing Trading and, in particular, Marc 
Rivalland’s approach to the technique, 
select InfoCentre from the View menu and 
you will find a tutorial on Swing Trading.

By default, ShareScope includes historical 
shares in its lists. These are the shares 
coloured green and which are no longer 
trading. To hide these shares, go to the 
View menu and de-select Show 
historical shares. 

Fresh back from business in India and 
Malaysia, to name but a few, and my view 
remains positive for the major indices. 
Here’s why: 

Firstly, P/E values for the UK and US 
markets are relatively low. This suggests 
that markets have upside potential. 

We’ve also seen the US Federal Reserve 
announce another round of quantitative 
easing. QE drives down bond yields 
making equities more attractive. Price 
inflation from QE pushes all nominal prices 
higher, including stocks.  

WHERE WILL EQUITY 
MARKETS BE ONE 
MONTH FROM NOW? DOMINIC
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One of the joys of ShareScope is how you 
can navigate around the screens with a 
single keystroke or mouse click. You can 
actually create your own shortcuts for 
the actions you perform most often. Go 
to the Tools menu and select Keyboard 
accelerators.... This will show you the 
actions that you can assign shortcuts to. 
If you click on the Available keys button it 
will show the keys not currently assigned. 

The Data Mining screen replaces the List 
screen in ShareScope’s view cycling. Select 
an instrument in the list of results and 
press the Enter key to cycle through the 
Graph and Details screen and then back to 
the Data Mining screen.

You have 12 Data Mining Tables for use 
with your filters. These can be configured 
just like normal List Tables. Find them in 
the Data Mining Tables menu.

Support:  Gold & Plus 020 7749 8504 / 0845 045 0111  Pro 020 7749 8503 / 0845 456 0545
The 0845 numbers should be cheaper if you are calling from outside London on a landline.

ShareScoop
SPECIAL OFFER
We are pleased to be supporting 
the launch of PortfolioReview - a 
new monthly publication edited by 
journalist David Stevenson. It presents 
an intelligent discourse on portfolio 
management and diversification. We 
know David well (he’s a ShareScope 
user!) and he is a champion of clear, 
unbiased information for investors. If 
you are managing a significant portfolio 
of investments, please visit  
www.portfolioreviewonline.com to 
see a sample copy. ShareScope users 
get £25 off the annual subscription 
which also includes free entry to the 
excellent monthly seminars. Go on, 
treat yourself for Christmas!

Phil’s 
Hidden Gems
PHIL TOLHURST, SUPPORT

Low bond yields also means cheap 
borrowing  and this combined with 
relatively cheap valuations encourages 
merger and acquisition (M&A) activity. 

Lastly, earnings are improving on the back 
of global growth. The S&P has already 
hit my target from the last issue of 
ShareScoop and I can see further upside. 
I give my short term trades and longer 
term stock picks in my monthly newsletter 
for subscribers to the Alpesh Patel Special 
Edition of ShareScope.

http://www.portfolioreviewonline.com


As investors, we have access to a 
wide range of asset classes, geographic 
regions and themes through collective 
instruments such as unit trusts, 
investment trusts and ETFs. I hold all 
three types of investment in my SIPP 
along with shares. And although most 
SIPP providers and fund supermarkets 
provide extensive web resources, doing 
meaningful research can be pretty 
tortuous. This is why we have added a 
large amount of information for funds 
and investment trusts which you can 
use to customise tables for fast analysis. 
Right-click in the table column headings 
and you will see options  
to Add Investment Trust 
columns and Add Unit  
Trust columns. For example, 
you can add the IMA sector 
(funds) or AIC sector code 
(investment trusts) and you 
can also filter the list by 
these sectors. To do this, 
right-click in the table and 
then click on Select sector. 

GM’s 
Column

Many unit trusts and investment trusts 
have been in existence long enough 
for you to add a column for the price 
performance over 10 years, as well as over 
the more common one, three and five 
years. I’ve used sector filtering and price 
performance columns to create the table 
of Investment Trusts in the Asia Pacific ex-
Japan sector shown below. 

Remember, you can add the most 
attractive looking investment trusts, unit 
trusts and ETFs into a portfolio for easy 
comparison. For even more information 
on a particular instrument, press CTRL-W 
to display the website for an investment 
trust or the Morningstar web page for a 
unit trust. 

If you are unsure of the difference 
between investment trusts and unit 
trusts here is a brief summary. Unit 
trusts are bought and sold through fund 
supermarkets or other intermediary. Their 
price is the value of their assets. You may 

be charged an initial fee and you will also 
be charged an annual management fee. 

For most funds, there is a single buy/
sell price but some have a spread (some 
of the popular Blackrock funds have a 
6% spread!).  As more people invest in 
the fund, the manager can create more 
units. Investment trusts are traded on an 
exchange (e.g. LSE) and will have a bid/ 
offer spread. Because they are exchange-
traded they may trade below (discount) or 
above (premium) the value of their assets 
(NAV). Investment trusts also charge an 
annual management fee. Look at the Total 
Expense Ratio (TER) of funds and trusts - 
this is a relative measure of the costs taken 
out of a fund by its managers. It includes 
the management fee, trading costs and 
other expenses. In addition, some funds 
and trusts may charge a performance fee. 
Importantly, investment trusts can also use 
gearing making them riskier investments.
Tim Clarke, General Manager

DATA MINING IDEAS
Borrowing is an essential facility for many 
companies - providing the leverage they 
need to grow or simply compete. Too 
much debt, however, can be a burden and 
have the reverse effect. With ShareScope’s 
Data Mining you can search for companies 
who appear to have a track record of 
putting debt to good effect. To sort out 
the level of a debt a company has taken 
on, you can use the Net gearing criterion 
– that is, borrowing minus cash (net debt) 
as a percentage of shareholder funds. 
In a recent article, Shares magazine 
suggested setting this to 50% or below. 
Now, with borrowing comes interest 
repayments and you’ll want to be sure 
that your companies can afford to meet 
their obligations. For this, add Interest 
cover and set the lower limit to two. That 
is, last reported pre-tax profits cover 
interest repayments at least twice. This in 
itself suggests a healthy balance sheet but 
let’s factor in tangible evidence of good 
management. You can do this by filtering 
for companies with a record of generating 
a good return on capital employed 
(ROCE). Try filtering for a ROCE of at least 
15% for each of the last five years. You 

might also want to search for companies 
in a strong competitive position so you 
could use ShareScope’s ranking facility 
to filter for companies whose Operating 
margin was in the top quartile for their 
subsector. This doesn’t always work – if 
a company is the only constituent of the 
subsector then the measurement isn’t 
very helpful. So you could also add the 
same criterion for sector. This, too, on its 
own isn’t a reliable guide as some sectors 
(e.g. Support Services) can have a diverse 
range of constituents. Combined though 
they probably remove the anomalies. 
To find companies ranked in the top 
quartile, set the range from 0.76 to 1.00.

You could also look for companies that 
have increased their operating margin 
since the previous set of results. All these 
criteria are found in the Advanced results 
and forecasts and Rank in Sector sections 
of the data mining wizard. If you need 
any help, please don’t hesitate to call our 
Customer Support team on 0845 045 0111. 

Help!
There is a vast amount of information 
in ShareScope’s Help facility. Go to the 
Help menu in ShareScope and click on 
Help - Contents and Search. The Help 
window will appear. There are three 
tabs: the Contents tab allows you to 
browse “chapters” of content (e.g. 
Portfolios); the Index tab enables you 
to search for a specific feature; and the 
Search tab enables you to search for 
any word or phrase. The Index tab is 
often all you need to find what you are 
looking for.  

What’s New?
As you know we frequently upgrade 
ShareScope with useful features. 
Whenever your copy of ShareScope is 
upgraded to a new release, we display  
a What’s New? document on the 
screen telling you what we’ve added. 
We suspect that many of you close 
these documents without reading 
them in your haste to check your 
investments! Fortunately, you can find 
a library of these announcements by 
clicking on the Help menu and then 
selecting What’s New?.

These ideas are not investment advice; 
you should not treat the results of 
any filters using these criteria as 
recommendations to buy or sell.



By default, ShareScope’s charts use a 
“Dynamic timescale” setting. This means 
that ShareScope will select a time period 
for bars or candles that best suits the 
space available. Note that this only applies 
when displaying OHLC bars or candlesticks. 
For example, if a graph fills the screen and 
shows a period of twelve months then 
there will probably be space to display one 
day bars or candles. If the same graph is 
reduced to, say, a quarter of the screen, 
then ShareScope may display, for example, 
4 day bars. That is, the open will be the 
opening price on the first day. The close 
will be the closing price on the fourth day 
and the high and low will represent the 

Melissa’s Top Tips
Dynamic Timescale

range traded over the four day period. You 
can see on the chart below how the range 
used is displayed in the top left of the 
chart. It is possible, however, to disable 
this feature so that a specified period is 
always used (e.g. one day). Right-click 
in the Graph window and select Graph 
design.... On the Time tab you will see 
the option Dynamic selection of scale is 
selected. Click on 1 day to ensure that 
your bars and candles always represent a 
single day.  You could use the same feature 
to configure Graph Settings which only 
display weekly or monthly bars.

Melissa Kearney, Support Manager

PERCENTAGE PRICE CHANGE
You can draw a line from one point to 
another on a graph and display the 
percentage price change between the 
two points. You can use this to show 
your profit/loss on a transaction. You 
can even attach the right hand point of 
the line to the latest price point so that 
the value will automatically update each 
day. This is useful for open positions. Plus 
and Pro users can attach the line to the 
latest intraday price which you can add 
to historical price charts. You can also 
add these lines to intraday graphs. To add 
a Percentage Change line, click on the     
button on the Graph toolbar, hold down 
the Shift key, click on the desired start 
point and drag the line to the desired end 
point. Then release the Shift key. Right-
click on the line and select Colour, style 
and settings... to make the line track the 
latest price (Extend to latest date/time) 
or to change the colour or thickness of 

the line. If displaying bars or candlesticks, 
right-click on the line and select Edit end 
point values... to set the start and end 
points of the line to an exact time or 
price. If you want to see the percentage 
change but don’t want the line to remain 
permanently, simply click on the toolbar 
button and draw the line without holding 
down the Shift key. Call 0845 456 0545 if 
you need help with this.

Remember, you can print ShareScoop 
in black & white if you want to save 
on coloured ink. The option to do this 
will be contained somewhere in the 
Print dialog that appears when you 
click on Print.

Rich’s 
Scripts
RICHARD CHIESA, SUPPORT

Those of you writing ShareScripts have 
probably noticed the limitations of doing 
so using Notepad: the text is monochrome 
and line numbers aren’t displayed which 
can make debugging a script a long and 
complicated business. This is why I prefer 
to use a text editor called Notepad++ 
which comes with numerous useful 
features including colour coding and line 
number display. You can download it for 
free from http://notepad-plus-plus.org.  
To tell ShareScope to use this editor, go to 
the Tools menu, then Options and select 
the ShareScript tab. On here, change the 
Text Editor path to that of your newly 
installed Notepad++. 

In this issue I would also like to draw your 
attention to Crossfinder: a column script 
that allows you to quickly identify a host of 
classic technical crosses. Simply download 
the latest version from the script library 
and load it as a list column. If the script 
returns a 1, the cross you were looking for 
has been identified.

Christmas Hours
Please note that early closing by the 
LSE on Friday 24th and Friday 31st 
December, and our Christmas party, will 
affect office hours and the end-of-day 
update over the festive period.

Date
Fri 17th Dec
Fri 24th Dec
Fri 31st Dec

Hours
8am-1pm
8am-1pm
8am-1pm

Update
6pm
1.30pm
1.30pm

http://notepad-plus-plus.org

